
 
 
 

 

 
 
 
 

PalmSens is a handheld and battery-powered interface for electrochemical 
sensors. It is designed for use with amperometric and voltammetric sensors. 
The instrument is in fact a potentiostat/galvanostat providing the most relevant 
electrochemical methods with a wide dynamic range.  
 
This document gives technical details of the PalmSens device used as a generic 
instrument and controlled by a Pocket PC. The instrument comes with the 
PSTrace program for desktop PC or laptop. This program is described in a 
separate document. 
 
 
General information is found on: www.palmsens.com. 
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Available voltammetric and amperometric methods and its 
specifications 

 
The embedded software of PalmSens provides all measurement methods which are 
relevant for electrochemical sensors. The voltammetric methods are used to measure a 
curve of current versus potential. Specific determinations require stripping chrono-
potentiometry. 
Amperometric and pulsed amperometric detection is used to record current as a 
function of time. Many textbooks give the theoretical background of these techniques. 
Two examples are: 
1. Christopher M.A. Brett and Ana Maria Oliveira Brett, Electroanalysis, Oxford 

Chemistry Series 64, Oxford University Press, ISBN 0 19 854816 
2. Joseph Wang, Analytical Electrochemistry Second Edition, Wiley-VCH, ISBN 0471-

28272-3 

Voltammetry and stripping chronopotentiometry 

 
The available voltammetric methods are: 
- Differential pulse voltammetry: DPV, 
- Square wave voltammetry: SWV, 
- Normal pulse voltammetry: NPV,   
- Linear sweep voltammetry: LSV, 
- Cyclic voltammetry : CV, 
- Ac voltammetry: acV. 
These methods can all be used in their stripping modes which are applied for (ultra-) 
trace analysis.  
 
If stripping voltammetry is used, a blank correction 
can be made using the method called subtractive 
stripping voltammetry. The blank is measured 
immediately after recording the original curve. The 
blank is measured without applying the conditioning 
and deposition stages. The blank curve is subtracted 
from the original curve (see for instance: E. Kirowa-
Eisner, M. Brand and D. Tzur in Anal. Chim. Acta, 
385, 325-335 (1999)). 
 
The stripping chronopotentiometry SCP (or PSA) 
methods are: 
- Chemical stripping at zero current,  
- Constant current stripping.  

 
 
 
All voltammetric methods as well as SCP allow blank subtraction by measuring a blank 
solution. 
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Amperometry 

The amperometric methods available on PalmSens are: 
- Amperometric detection: AD 
- Pulsed amperometric detection: PAD 
- Multiple pulse amperometric detection: MPAD 
- Fast amperometry, with sampling rates of 1000 points per second. 
 
The signals evaluated from a measured curve are either the steady-state currents or 
the peak heights. These methods can be used with a flow-cell for CFA as well as FIA. 
 
 

Potentiometry 

Potentiometry with an interval time of 0.1 s or more is done at open circuit or at a fixed 
current. 

 
 

Specifications of the available methods 

All electrochemical parameters can be specified by the user. The actual measurement 
is performed after a pretreatment stage. This pretreatment is sometimes required to 
condition the electrode and to deposit the analyte(s) in case of stripping analysis. 
During these stages, the potential and current as well as elapsed time are shown on the 
display of PalmSens. 
 
The specifications of most of the relevant parameters are: 
 

General pretreatment: General voltammetric parameters: 
 
Apply conditioning potential for:  0 – 1600 s 
Apply deposition potential for:  0 – 1600 s  
Apply begin potential for:                0 – 1600 s 
 
Conditioning potential: -2.000 V to + 2.000 V 
Deposition potential: -2.000 V to + 2.000 V 
Standby potential: -2.000 V to + 2.000 V 

 

 
Begin potential: -2.000 V to + 2.000 V 
End potential: -2.000 V to + 2.000 V 
Step potential: 1 mV to 250 mV 
 
Pulse potential: 1 mV to 250 mV 
ac-amplitude:  1 mV to 250 mV 
 

 
Limits of some technique specific parameters are:     

DPV: Scan rate: 
Pulse time: 

1 mV/s (1mV step) to 50 mV/s (5 mV step) 
1 ms to 300 ms 

SWV: Frequency: 1 Hz to 400 Hz 

SCP: Sampling rate: Approx. 40 kHz., max. 100 s 

LSV and CV: Scan rate: 0.2 mV/s (1 mV step) to 5 V/s (5 mV step) 

AcV: Scan rate: 
Frequency: 

1 mV/s (1 mV step) to 25 mV/s (5 mV step) 
28 Hz to 90 Hz 

AD and PAD: Interval time: 
Pulse time: 
Run time: 
Mode: 
 
Maximum number 
of points: 

50 ms to 300 s 
1 ms to 1 s 
10 s to 100000 s 
dc-amperometry and normal pulse and 
differential pulse. 
 
30000 
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MPAD: Pulse times: 
Run time: 
Number of 
potential levels: 
Maximum  number 
of  points: 

10 ms to 2 s 
10 s to 100000 s 
 
3 
 
30000 

Fast 
amperometry 

Interval time: 
Maximum run time: 
Maximum number 
of points: 

1 ms to 1 s 
30 s 
 
20000 

Potentiometry 
at open circuit 
or constant 
current 

Interval time: 
Maximum run time: 

100 ms to 30 s 
100000 s 

Note: some limits of parameters are set for practical reasons and can be modified on request. 
    

           
      

 
The applicable potential range is –2.000 V to + 2.000 V, 
with a resolution of 1 mV. The resolution of the sine 
wave in ac-voltammetry is 0.25 mV. 
The applicable current ranges are 1 nA, 10 nA, 100 nA, 
1 µA, 10 µA, 100 µA, 1 mA and 10 mA. The maximum 
current from the instrument is more than 10 mA.  
The resolution of the current measurement is 0.1 % of 
the applied current range, which equals 1 pA on the 
lowest current range. 
During a measurement the current range can be 
optimized automatically to the current value. Users can 
limit the selectable current ranges to, for instance, 100 
nA, 1 µA to 10 µA. 
 
The bandwidth of the potential and current control is 
approx. 50 µs. 
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Pocket PC software and its specifications 

PalmSens is controlled by a Pocket PC. This device is used to specify all parameters, 
to display the measured curves and to evaluate them. Measured curves can be stored 
in the memory of the Pocket PC and later easily transferred to a PC. The Pocket PC is 
connected to PalmSens by means of a serial cable. 
PalmSens is delivered with two programs:  
- PalmScan for measurements of voltammograms ( i vs E plots ) or SCP curves, 
- PalmTime for (pulsed) amperometric detection and potentiometry. 
 
Both these programs provide almost the same menus:   
 
 

       
File menu   Edit menu   Plot menu           Measure menu  Instrument menu 

 
 
The File menu is used to load and store methods and measurements. A sample curve 
is stored as a standard text file with potential and current values. These files are easily 
imported in other programs. 
Storing an analysis yields a file with the method parameters as well as all voltammetric 
curves. The recordfile is a plain text file in which the results of an analytical 
determination are written. Obtained curves can be stored as bitmap files which are 
easily imported in Windows programs. 
 

 
 
 
The complete set of parameters can be stored as a standard method. Users can make 
their own library of standard methods. 
 
The Plot menu allows re-scaling curves in different ways as well as a manual peak 
search method in case the automatic peak search fails. 
 
The Analysis plot shows the calibration or standard addition curve for each analyte. 

Access to the electrochemical as well 
as analytical parameters is provided by 
the Edit menu.  
 
Their values are edited by using a 
scrollbar. 
 
Specified values are checked for 
inconsistencies. In case a wrong value 
is detected, an error message is 
generated. 
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The Measurement Settings 
window allows specification 
of instrumental parameters, 
like applicable current 
ranges and the use of a 
stirrer.  
 
The Plot Settings window 
allows setting the behavior 
of the plot window like 
marking peak height, 
smoothing and grid.  
     
 
 
 
 
 
 
 
 

 
 

The Control window provides manual control of 
the potentiostat and galvanostat. 
 
 
The measured values of the potential and current 
are continuously displayed.  
The status window is used to signal voltage or 
current overloads. A voltage overload might 
indicate a problem with the reference electrode.  
The noise value indicates electrical interferences 
from external sources. 
In case of problems their background-colors are 
yellow or red. 
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The PalmScan program 

The PalmScan software is used for voltammetric measurements and determinations. 
The program can measure a blank, the sample and up to four standard solutions. In a 
single measurement up to four analytes can be identified. 
 
The standard sequence of a measurement of each voltammogram is: 
1. Apply the conditioning potential, if the conditioning time is not zero. 
2. Apply the deposition potential, if the deposition time is not zero. 
3. Apply the begin potential and wait the equilibrium time. 
4. Scan the potential until the end potential with the specified step size and scan rate. 

In CV the scan is continued by reversing the scan direction. The current range is 
changed automatically if necessary. 

5. If the measurement rate is less than 25 points per second then the measured points 
are displayed on-line. During the measurement the plot can be re-scaled 
automatically. If the scan rate is too high the points are plotted after completing the 
scan.  

6. In case subtractive stripping is specified, the background is measured by returning 
to step 3 and subtracting this new voltammogram from the original one. 

7. If the cell must remain switched on, the standby potential is applied, otherwise the 
cell is switched off. 

  
After each measurement automatic peak search is performed. Peaks are identified with 
their peak potential. The signal used for calculating the concentration is the peak 
height.   
Peak heights are automatically corrected for their baselines, by means of a tangent-fit 
method. Peaks are identified only if the peakheight exceeds a minimum value, the peak 
width is larger than a specified value and the peak potential fits within the peak window. 
In case standard addition is performed the peaks are corrected for dilution effects. 
 
 
Blank correction is optionally performed by means of 
the method called subtractive stripping voltammetry 
or by measuring a voltammogram of the blank 
solution. 
 
Concentrations are calculated in user-specified units.  
 
The Instrument menu shows the option to pretreat the 
sensor. This pretreatment allows users, for instance, 
to plate the sensor with a mercury film or to condition 
the sensor. The pretreatment consists of up to five 
potential steps. During the pretreatment the 
measured curve is displayed and integrated to a total 
charge. After this pretreatment, scans can be made in 
order to stabilize the sensor.
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 The Plot menu allows automatic and manual rescaling 
as well as manual peak search by specifying the 
baseline graphically. 

 
The File menu provides different options to store 
measurements: 
- a single curve, 
- an analytical determination with curves of the 
blank, sample and standards, 
- the analytical result with sample identification, 
sensor description, date and time. 
Users can create their own library of analytical 
methods. 

 
 
 
 
 
 
 
 

The PalmTime program 

This program is used for amperometric and potentiometric measurements, which 
means that current or potential as a function of time is recorded. The Edit menu of the 
program gives access to the amperometric as well as analytical parameters. Their 
values are entered by using a scrollbar or by tapping the keyboard on the screen.  
 
 

    
 
An amperometric determination can be done by using up to 8 calibration solutions. The 
unit of concentration is specified by the user. The signal used for the determination can 
be steady-state current or peak height. 
 

The PalmTime program supports the CH8 multiplexer for sensorarrays. The program 
allows measurements of up to eight  curves obtained from different sensors. 
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PalmSens Instrumental  specifications  

Controlled potential mode (potentiostat): 
 
- dc-potential range   ± 2.000 V    
- compliance voltage  ± 8.0 V  
- dc-potential resolution  1 mV 
- dc-offset error   2 mV  
- accuracy    ≤ 0.2 %  
- ac-potential amplitude  1 mV to 250 mV 
- current ranges   1 nA to 10 mA (8 ranges) 
- maximum current   ± 10 mA 
- current resolution   0.1 % of current range 
     1 pA on lowest current range 
- accuracy    ≤  0.2 % of current range at 100 nA to 1 mA 

≤  0.5 % at 10 nA   and ≤  1 % at 1 nA   
   all with additional 0.2 % offset error  

 
Controlled current mode (galvanostat): 
 
- current ranges   1 μA to 1 mA  
- dc-current range    -2 to + 2 times  selected current range 
- dc-current resolution  0.1 % of selected current range 
- dc-offset error   ≤  0.2 % 
- current  accuracy    ≤  0.4 % 
- maximum output voltage  ±  8 V 
 
 
General: 
- electrometer amplifier input  > 100 Gohm // 4 pF 
- rise time    approx. 50 μs 
 
Keypad     ▲►▼◄ ENTER ESC and Power (7 keys) 
Display     4 lines of 16 characters with backlight 
Dimensions     155 mm x 85 mm x 35 mm 
Temperature range   0º C to + 40º C    
Weight     0.43 kg 
Power     2 AA cells NiMH 2700 mAh  for > 8 hours operation. 
      Battery charger included (6 V- 1500 mA) 
Interfacing     Serial RS232  
External I/O    Analog: 1 input and 1 output channel (0 V - 4.096 V) 
     Digital:  1 input and 4 output lines 
 
 
Expansions supported by Pocket PC software:     
 
A magnetic stirrer controlled by PalmSens is available for stripping analysis applications. The stirrer is 
switched on during the conditioning and deposition stages. 
 

CH8 is a multiplexer for use with 2 to 8 sensors. It is connected to the PalmSens instrument. This device 

allows application of sensorarrays with up to eight working electrodes sharing the reference and counter 
electrodes, but also with eight working, eight counter and eight reference electrodes. The device can also 
be used with two-electrode sensorarrays. 

 
 
Please do not hesitate to contact Palm Instruments for more details: info@palmsens.com . 
 
Palm Instruments BV 
The Netherlands  
www.palmsens.com      

 

mailto:info@palmsens.com
http://www.palmsens.com/

